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What is SensorDAQ? 
 

The SensorDAQ® interface provides connectivity between Vernier or custom 
sensors and a Windows computer running LabVIEW software. More than 
50 Vernier sensors are available for use with the SensorDAQ.  
 
You can also combine the use of sensors connected to the SensorDAQ with 
the output of Vernier's Digital Control Unit (DCU) or the SensorDAQ's 
screw terminal for control projects. Examples include alarm systems and 
temperature-controlled environments. 
 

  
By following this guidebook, you will learn to:  

 Set up and collect data using Vernier sensors. 
 Find sample programs. 
 Access the SensorDAQ palette. 

 
SensorDAQ Equipment List  
 
The SensorDAQ package contains the following equipment:  
 SensorDAQ interface 
 User’s Manual 
 Vernier Voltage Probe 

 

 USB cable 
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Quick Start  

Install National Instrument Software 
Install National Instruments LabVIEW software and device driver software. 

1. Install National Instrument’s LabVIEW software. If LabVIEW is already 
installed on your computer, check the version of LabVIEW you are 
using. 

2. Install National Instrument’s NI-DAQmx device driver software. This 
software is included with LabVIEW or can be downloaded for free from 
www.ni.com. 

Connect Equipment 
3. Connect the USB cable to SensorDAQ.  

4. Attach the other end of the USB cable to any unused 
USB port on your computer. 

5. If the NI-DAQmx driver software is properly 
installed the computer should provide a “Found New 
Hardware” message and the SensorDAQ LED next 
to the USB cable port on the SensorDAQ should be 
blinking. 

Install the SensorDAQ Files 
6. Our SensorDAQ example files are posted on the Vernier web site as a 

free download. Locate the download page and follow the installation 
instructions for SensorDAQ. All of our LabVIEW downloads can be 
found at: https://www.vernier.com/engineering/ni-labview/downloads/ 

Start LabVIEW and Collect Data with SensorDAQ  
The following example is an advanced LabVIEW program that is very useful 
for testing your equipment and collecting data. To find information on our 
many LabVIEW example programs go to the section called SensorDAQ 
Example VIs.  

7. Connect a Vernier Auto-ID sensor to Ch. 1. 

8. Start LabVIEW 

9. Open the NI Example Finder by choosing Find Examples from the Help 
menu. 
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10. Select Directory Structure in the upper-left corner.  

11. From the list of folders, choose Vernier. 
12. Open the folders SensorDAQ LabVIEW Examples » Log and Analyze 

Data » Log with Analysis and single-click the SensorDAQ Logger.vi to 
view the description of this example in the Information box. 

 
13. Double-click SensorDAQ Logger.vi to open it. 

14. Start the example by clicking LabVIEW’s white Run arrow  in the 
upper left corner. 
Tip: If LabVIEW has successfully detected the SensorDAQ, you will see 
the device icon appear in the upper left corner (see below), along with 
the sensor reading. In this example a temperature probe was connected.  

 
15. Click the Collect button . LabVIEW will begin plotting data in the 

graph. 

16. Once data have been collected, click and drag the mouse on the graph to 
highlight data. Click on the various analysis buttons in the toolbar 
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(Zoom, Examine, Statistics, Integrate, Linear Fit, and Curve Fit) to study 
your data. 

17. Stop this VI by selecting Exit from the File menu. 

You have now successfully set up your equipment, collected data, and 
performed analysis. Keep reading for information on the hardware, the 
LabVIEW examples, and the SensorDAQ palette. 
SensorDAQ Palette 
 
The SensorDAQ is a device that is designed to be programmed using 
LabVIEW development software. Use the SensorDAQ palette of Express 
VIs and driver VIs to communicate with the device and perform control and 
data logging. Combine this with all of the power of LabVIEW to create 
custom programs, perform data analysis, generate reports, post to the web 
and more. 
 

Accessing the SensorDAQ Palette 

 
 
As you customize an existing SensorDAQ example (or even if you are 
building a new program from scratch) you will need access to the 
SensorDAQ Express VIs and driver VIs. These are located in the functions 
palette and are placed on the block diagram by clicking and dragging. The 
functions palette is accessed in LabVIEW by selecting View » Functions 
Palette or right-clicking in the block diagram workspace. If you do not 
immediately see the SensorDAQ palette click on the Search button at the top 
of the functions palette and search “SensorDAQ”. If there are no SensorDAQ 
results in the search the SensorDAQ files were not properly installed. 
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Analog Express 

 
 
This Express VI should be your starting point for learning how to program 
the SensorDAQ. It allows you to test your hardware and build a useful 
LabVIEW program in a quick and clean method. Simply click and drag the 
Analog Express VI into the block diagram. The Express VI will provide a 
configuration window that allows you to configure all five analog inputs, 
view and modify the calibration coefficients, zero the sensor reading, choose 
the sensor units, set the data-collection rate, length of the experiment, as well 
as any triggering.  
 
Click the Help button in the Analog Express VI’s configuration window for 
information on how to use this Express VI to build your LabVIEW VIs. 

Digital Express 

 
 
Use this Express VI to configure data acquisition from the Vernier Motion 
Detector, Photogate, DCU, and Rotary Motion Sensor connected to the DIG 
Channel. Simply click and drag the Digital Express VI into the block 
diagram. The Express VI will provide a configuration window that provides 
feedback on your hardware connections.  
 
Click the Help button in the Digital Express VI’s configuration window for 
information on how to use this Express VI to build your LabVIEW VIs. 

Power Amp Express 

 
 
Use this Express VI when using the Vernier Power Amplifier connected to 
the SensorDAQ Analog Output screw terminal. The Power Amplifier allows 
you to amplify the SensorDAQ output up to 10V, as well as drive loads that 
require up to 1 ampere of current.  
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Data Logging 

 
 
The data logging palette of subVIs are designed for building LabVIEW 
programs that have the features and analysis required for classroom 
experimentation. View the examples in the Data Logging folder to see how 
these driver VIs, analysis VIs, and Utility VIs can be used. 

DCU Control 

 
 
The Vernier Digital Control Unit (DCU) is a piece of hardware that connects 
to the SensorDAQ DIG Channel and provides useful current to digital output 
lines. The DCU Control VIs allow you to easily build programs for 
controlling these output lines, including outputs based on sensor readings and 
outputs required for stepper and servo motors. 



 

SensorDAQ User's Manual 7

Low Level Drivers 

 
 
In most cases the Express VIs, the DAQ Assistant, the Data Logging palette, 
and the DCU palette provide the flexibility and power you will need for 
creating your custom SensorDAQ program. The Low Level Driver VIs may 
be useful if you do require more flexibility, and there are many examples in 
the example folder with the name Advanced Low Level that show how to use 
this palette. However, these examples also add more complexity. 

DAQmx API 

 
 
The DAQmx device driver software will install a DAQmx API that is 
available in the LabVIEW programming environment. This palette, found in 
the Measurement I/O palette, provides the most flexibility and power for 
communication with SensorDAQ. Of course, it also means increased 
complexity. For most users the SensorDAQ drivers and Express VIs provide 
the appropriate flexibility, ease-of-use, and power, and the DAQmx API will 
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not be used or viewed. However, if you have experience using DAQmx API, 
or if you require the low-level flexibility, we have provided some examples 
that show how to use DAQmx API with SensorDAQ. They are labeled 
Advanced Low Level in the example folders. There are a few differences in 
configuring a DAQmx task for the SensorDAQ sensor channels that can be 
seen in the examples, such as setting up the channel names of these channels. 

DAQ Assistant 

 
 
The NI-DAQ Assistant is an Express VI wrapper of the NI DAQmx API, 
installed with NI-DAQmx device driver software, found with the DAQmx 
API in the Measurement I/O palette. The DAQ Assistant supports the screw 
terminal channels of SensorDAQ, and is a great way to program these 
channels. However, the DAQ Assistant does not support the Sensor 
Channels. Use the SensorDAQ Analog Express VI as an alternative Express 
VI for configuring the Sensor Channels. 
 
SensorDAQ Components 
 
SensorDaq features four channels to connect Vernier sensors (three analog, 
one digital) as well as a screw connector providing two analog input (AI) 
channels, one analog output (AO) channel, four digital input/output (DIO) 
channels, and a 32-bit counter/timer (PFI). 

 
SensorDAQ back view  

1. The USB Cable Strain Relief is used to ensure a secure USB connection. 
2. Use the Mounting Slot and Panel Mount to mount SensorDAQ to an 

object.  
3. The LED blinks when SensorDAQ has power and is recognized by the 

DAQmx driver. 
4. The USB Port is for computer connection. 
5. Use the Tie Wrap Point to lock down and secure the device.  
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SensorDAQ side view 

 
1. Ch.1–Ch.3 BTA (British Telecom Analog) channels for Vernier analog 

sensors. The Vernier voltage probe is an analog sensor.  
2. Use the Mounting Slot and Panel Mount to mount SensorDAQ to an 

object.  
3. The Screw Terminal Connector is available for customized input and 

output. The screw terminal can be removed after being wired for specific 
experiments. Replacement terminals are available from Vernier. 

4. DIG BTD (British Telecom Digital) input/output channel for Vernier 
digital sensors. 

 
Providing Power to SensorDAQ 
  
SensorDAQ is powered by the USB cable from the computer. 
 
Connecting Sensors and Signal Lines 

SensorDaq is designed to work with Vernier’s LabQuest line of sensors. 
These sensors can be identified by their order code. The analog sensors will 
have an order code that terminates with a –BTA (such as PH-BTA), and the 
digital sensors will terminate with a –BTD (such as MD-BTD). The 
SensorDAQ is not compatible with Vernier’s Go Direct® line of sensors.  

Vernier Analog Sensors 
Sensors can be divided into two basic types—analog and digital. Examples of 
analog sensors are Voltage, Temperature Probes, pH Sensors, Force Sensors, 
and Oxygen Gas Sensors. Up to three analog sensors can be connected to 
SensorDAQ at any time1. The channels for the analog sensors (Ch.1–Ch.3) 
are located on the left side. The analog ports accept British Telecom-style 
plugs with a right-hand connector.  
 

                                                 
1 Due to the high power consumption of some Vernier CO2 Sensors, only one CO2 Sensor 

can be used at a time with SensorDAQ. 
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Pin 1 = Sensor output (+/-10V) 
Pin 2 = GND 
Pin 3 = Vres (resistance reference) 
Pin 4 = AutoIDENT (used for auto-ID 
of most Vernier sensors) 
Pin 5 = Power (+5VDC) 
Pin 6 = Sensor output (0-5V) 

 
Most sensors provided by Vernier are auto-ID sensors. When you plug an 
auto-ID sensor into SensorDAQ, the software will be able to identify it and 
set up the file accordingly. Auto-ID information includes default settings for 
data collection rate, length of collection, and calibration coefficients. 
Most Vernier analog sensors send a raw voltage signal in the range of 0-5V on 
pin 6. A few send a signal in the range of ±10V on Pin 1. The raw voltage 
signal is converted to proper units using the sensor’s calibration coefficients.  
Most Vernier sensors that plug directly into SensorDAQ without an adapter 
are auto-ID. However, the SensorDAQ can read a 0-5V or ±10V signal from 
many types of sensors. To make the connection to SensorDAQ with a sensor 
without a BTA plug, use an adapter (www.vernier.com/adapters/), or a bare 
BTA cable (order code BB-BTA) wired to your custom sensor.  

Vernier Digital Sensors 
 
Pin 1 = I/O1 
Pin 2 = I/O2 
Pin 3 = I/O3 
Pin 4 = PWR (5.08V) 
Pin 5 = GND 
Pin 6 = I/O4  

Examples of digital sensors are Motion Detectors, Photogates, and Rotary 
Motion Sensors. One digital sensor at a time can be connected to SensorDAQ. 
The digital channel (DIG), which accepts British Telecom-style plugs with a 
left-hand connector, is located on the opposite side of the analog channels. 
 
The SensorDAQ’s DIG Channel also accepts a Vernier Digital Control Unit. 
This is a small box with a short cable that uses the DIG channel to provide 
output (up to 600 mA of current) for controlling electrical devices.  

Screw Terminal  
 
SensorDAQ screw terminal connectors can be used for input or output. 
When used for output, these connectors provide a limited current (see specs 
below); therefore, in some cases you will have to provide an external power 
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source. The +5V terminal can be used as your voltage source. This source 
can only supply 200 mA maximum.  
 
Note: A convenient option for running devices using digital output lines is 
the Vernier Digital Control Unit (DCU). The DCU plugs directly into the 
DIG channel and can supply up to 600mA of useful current to output lines. In 
addition, the Vernier Power Amplifier (order code PAMP) can be used with 
the screw terminal outputs to drive loads up to 1 A. 
 
The table below describes the signals available on the  screw terminals. 
 

 
Screw terminal connector pinout 

 
Terminal Signal Name Reference Direction Description 

5,8,10 GND — — Ground: Reference point for single-
ended AI measurements, bias current 
return point for differential mode 
measurements, AO voltages, digital 
signals at the I/O connector, +5 VDC 
supply, and the +2.5 VDC reference. 

11,12 AI <0..1> Varies Input Analog Input Channels 0 and 1: 
For single-ended measurements, 
each signal is an analog input 
voltage channel. For differential 
measurements, AI 0 and AI 1 are 
the positive and negative inputs, 
respectfully, of differential analog 
input channel 0. 

9 AO 0 GND Output Analog Output Channel 0: Supplies 
the voltage output of AO channel 0 
from 0-5V with an output current 
drive value of 5 mA. The maximum 
update rate is 150 Hz, software 
timed.  

1-4 P0.<0.3 GND Input or 
Output 

Digital I/O Signals: You can 
individually configure each signal 
as an input or output.  
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6 +5 V GND Output +5 V Power Source: Provides +5 V 
power. 

7 PFI 0 GND Input  PFI 0: This pin is configurable as 
either a digital trigger, an event 
counter input, pulse generation 
output, or as a period, semi-period, 
two edge separation timer.  

 
Analog Input Wiring 
In the differential input setting, connect the the positive lead of the source to 
the AI(0) terminal, and the negative lead to the AI(1) terminal. The differential 
input mode allows the SensorDAQ to measure a voltage difference on these 
terminals up to +20V or –20V in the ±20V range; however, the maximum 
voltage on any one terminal cannot exceed ±10 V with respect to GND. In the 
referenced single-ended input mode setting, connect the positive lead of the 
source to either AI channel terminal, AI(0) or AI(1), and the ground or 
negative lead to the GND terminal.  
 
Analog Output Wiring 
The SensorDAQ has one AO channel that can generate an output from 0–5V. 
The AO has an output current drive value of 5 mA. The maximum update 
rate of the channel is 150 Hz, software timed. To connect loads to the 
SensorDAQ, connect the positive lead of the load to the A0 terminal, and 
connect the ground lead of the load to a GND terminal. 
 
Digital I/O 
In addition to supporting Vernier digital sensors, the SensorDAQ has four 
digital lines, P0.<0..3>, which comprise the DIO port. GND is the ground-
reference signal for the DIO port. The default configuration of the 
SensorDAQ DIO ports is open collector, allowing 5 V operation, with an 
onboard 4.7 kΩ pull-up resistor. An external, user-provided, pull-up resistor 
can be added to increase the source current drive up to 8.5 mA limit per line.  
 
Counter/Timer 
SensorDAQ has a counter/timer that can be configured for pulse output, 
timing input, event counting, or as a digital trigger. 
 
SensorDAQ Example VIs 
 
The best way to get started with SensorDAQ is to open and run examples. 
You can use the examples without modification for data logging with 
analysis, for control, to perform output, to troubleshoot your hardware, and 
as starting points for your own custom program. 
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The SensorDAQ examples are located in the LabVIEW\examples\Vernier 
directory. An easy way to find the examples is to launch the LabVIEW 
Example finder. The Example Finder is launched by selecting Find Examples 
from the Help menu. Select Directory Structure in the upper-left corner, and 
locate the Vernier folder. 
 
The examples are stored in descriptive folders. Locate the folder that best 
matches your sensor or how you plan to use the hardware. For best results, 
explore all of the example folders and open a sampling of examples. Inside 
the folders you may find examples labeled Starter. Open these examples first. 
They are designed as a starting point for testing the hardware and learning 
the LabVIEW code. There may also be subfolders that are labeled Advanced 
Low Level. In general, these examples will only be useful if you require a 
higher level of flexibility for communicating with the SensorDAQ. 
 
The folders are explained below: 

Digital Control Unit (DCU) 
The Vernier DCU connects to the DIG Channel and provides output lines 
that can control small electric devices. This is a great device for classroom 
projects or discussion of sensor control. In this folder you will find examples 
showing how to control the output lines, how to control lines based on sensor 
readings going above or below threshold values, and how to control servo 
and stepper motors connected to the DCU. 

Feedback and Control 
The SensorDAQ screw terminal provides digital input and output, analog 
input, analog output and pulse output. The examples in this folder provide 
examples of feedback and control using the screw terminal channels. 

Log and Analyze Data 
These are examples that are great for running science and engineering-type 
experiments in the classroom. In this folder you will find examples with the 
features required for collecting data and performing some type of analysis on 
the data including; linear fit, curve fit, integral, statistics, tangent, and more. 
In addition you will find examples for creating XY graphs, performing 
events with entry, saving data to file, building tables, zeroing a sensor 
reading, changing sensor units and more. 
 
Inside this folder is a LabVIEW example VI called “SensorDAQ Logger.vi”. 
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This is an advanced example where Channels 1-3 can be used to collect data 
with Vernier analog sensors, and the screw terminal inputs AI0 and AI1 can 
be used to collect data with custom analog sensors. These five analog inputs 
can be configured, and the calibration coefficients modified. Clicking on the 
Data Collection button configures the data-collection rate, length of the 
experiment, as well as any triggering. Once data have been collected, there 
are some analysis features that can be used. If you would like to analyze a 
small portion of the data, simply click and drag your mouse to highlight the 
region, or use the Zoom tool to zoom in or zoom out. Data can be stored and 
deleted to compare against other runs, as well as saved to file.  

Motion Detector 
The Vernier Motion Detector connects to the DIG Channel. We have created 
an Express VI for the Motion Detector that can be used to create quick, 
simple and clean LabVIEW examples. If you are using the Motion Detector, 
start by viewing the Express VI examples in this folder. 

Physiology Sensors 
Vernier provides sensors such as blood pressure, ekg, heart rate, respiration 
monitor, and spirometer. These examples are similar to the examples located 
in the Data Logging folder. They provide the features that allow you to 
collect and analyze the data. Of course the analysis in these examples is 
specific to the sensor. 

SDAQ Analog Sensors 
The examples in this folder show how to read data from analog sensors. The 
Analog Express VI is the focus of these examples because it provides a very 
simple, quick and clean method for programming the analog sensors. If you 
are just getting started with SensorDAQ, with LabVIEW, or with teaching 
how to program the SensorDAQ, the Express VI and these examples should 
be the starting focus. 

SDAQ Digital Sensors 

This folder contains examples for the Vernier Photogate, Radiation, and 
Rotary Motion sensors. The Vernier DCU and Motion Detector are also 
digital sensors, but have their own folder of examples that were detailed 
above. 

SDAQ Pulse Output 
The SensorDAQ has two counters as part of the hardware. One counter is 
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available on the screw terminal, and the other is hidden on the DIG Channel. 
To access the hidden line, connect the DCU to the DIG Channel; line 1 of the 
DCU is the pulse output line. These counters can be used to provide a pulse 
output or a pulse train. The examples demonstrate how to do this.  

SDAQ Screw Terminal 
These are examples that demonstrate analog input, analog output, counter 
counting and timing, digital input and digital output from the screw terminal 
channels. You will find additional screw terminal examples in the Feedback 
and Control folder.  
 
NI Measurement and Automation Explorer (MAX) 
 
If you have worked with other National Instruments hardware and LabVIEW 
software, you may be familiar with MAX.  
 
MAX is a software application that is installed with NI-DAQmx device 
driver software. This application can be used to determine if the SensorDAQ 
hardware and NI-DAQmx software have been properly installed. MAX Test 
Panels can also be used to test the SensorDAQ channels. However, only the 
screw terminal channels will appear in the pull-down list of Channel Names. 
The Vernier Sensor Channels will not automatically appear in the list. You 
can manually enter the Sensor Channel names and still perform a test. For a 
common Vernier Sensor connected to Ch.1, that reads from the 0-5 Volt 
sensor line the inputs are as follows: 
 
Channel Name: "Dev1/_sensor0_5V"  
Max Input Limit:  5 Volt  
Min Input Limit:  0 Volt 
Input Configuration: RSE 
 
For a Vernier Sensor that reads from the +-10 Volt sensor line (Voltage 
Probe and Microphone) the inputs are as follows: 
 
Channel Name: "Dev1/_sensor0_10V"  
Max Input Limit:  10 Volt  
Min Input Limit:  -10 Volt 
Input Configuration: RSE 
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Resources 
 
The following manuals and resources provide detailed information about 
SensorDAQ and LabVIEW.  
 
Learning LabVIEW 
Vernier has released a book called Hands-On Introduction to LabVIEW with 
Vernier. This book introduces NI LabVIEW programming through a series 
of hands-on exercises using Vernier sensors and SensorDAQ, LabQuest or 
LabQuest Mini. Besides learning the basics of NI LabVIEW programming, 
your students will get started collecting and analyzing data.  
 
Engineering Projects with LabVIEW 
Vernier has released a book called Engineering Projects with NI LabVIEW 
and Vernier. This book contains engaging hands-on projects for SensorDAQ, 
LabQuest, or LabQuest Mini. It introduces engineering concepts and 
programming with LabVIEW. An introductory knowledge of NI LabVIEW 
programming is assumed.   
SensorDAQ Specifications 
This guide, available on the SensorDAQ web page, describes SensorDAQ 
technical specifications.    
DCU Manual 
The Digital Control Unit (DCU) gives you an easy way to use SensorDAQ's 
digital channel for exciting, do-it-yourself projects.   
Math Machines 
Math Machines www.mathmachines.net creates customized connector and 
control experiments for teachers using SensorDAQ.  
National Instruments LabVIEW Support 
The National Instruments web site is a complete resource for LabVIEW 
software support. Go to www.ni.com/academic/learn_labview to find 
resources for learning LabVIEW. 
  
Troubleshooting 
 
 If the SensorDAQ LED does not blink, the NI-DAQmx driver may not be 

properly installed. Try re-installing the driver. Reboot the computer after 
installing the driver.  

 If the SensorDAQ LED is blinking, but the LabVIEW examples do not 
detect SensorDAQ, you may have installed a version of NI-DAQmx that is 
not compatible with your version of LabVIEW or your computer OS. Open 
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NI’s Measurement and Automation Explorer application to determine the 
DAQmx version. You may need to update your version of NI-DAQmx 
from www.ni.com.  

 If the SensorDAQ LED is blinking, but the LabVIEW examples do not 
detect SensorDAQ, unplug SensorDAQ's USB cable, reboot the computer, 
then reinsert the USB cable to SensorDAQ.  

 The USB cable, or the USB port of the computer may not be responding 
properly. Try a different cable and a different port.  

 If you create a LabVIEW VI with the DAQ Assistant you must run the VI 
with the same SensorDAQ that was connected to the computer when you 
configured the DAQ Assistant. Switching SensorDAQs will cause an error 
when you run your program. Delete the DAQ Assistant and reconfigure a 
new DAQ Assistant, or go to MAX and update the device number of the 
SensorDAQ. 
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NOTES
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NOTES 


